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Chapter 1

Introduction

Basic information regarding 3D World and 3D World plug-ins, including
installation instructions and technical support details.
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◆ Introduction

Thank you for choosing 3D World, the affordable, easy to use alternative to today's complex 
3D applications for the Macintosh¨. Designed for novices as well as professionals, 3D World 
provides the tools you need to create professional 3D designs, animations and QuickTime¨ 
movies.

In addition to a core application suitable for viewing and manipulating existing 3D Þles, 3D 
World offers a plug-in architecture that makes it easy to add tools and extend the programÕs 
functionality. Plug-ins can be palettes, tools, menu items or idlers and can be loaded as the 
application is launched or ÔhotÕ loaded while 3D World is running. Information about the plug-
ins available is provided in this manual.

Additional rendering options, such as transparent surfaces and interactive constructive solid 
geometries, are available through supported QuickDraw 3D hardware renderers, and plug-in 
renderers from third party companies can be accessed by 3D World if they are installed in the 
Extensions folder. For added convenience, the 3D World product also includes the Librarian 
utility for cataloging and retrieving frequently used 3D objects, textures, and sounds.

Take a look at the extra items on the CD which are not installed on your hard drive during the 
installation procedure. Use the sample textures, libraries and 3D Þles to quickly and easily cre-
ate 3D documents, view the movie Þles to see some simple examples of animations created in 
3D World, and play the demo movies for a brief explanation of some 3D World features. Plus, 
demo copies of PhotoFix, MacInteriors, MacDraft, MacPalette and MacPlot drivers are 
included for those who are interested in other Microspot products.

◆ Requirements

3D World minimally requires:

¥ Power Macintoshª with CD drive

¥ System 7.1.2 or later

¥ QuickDrawª 3D 1.0.2 or later (The version of QuickDraw 3D available at release date is 
included.)

¥ 16 Mb RAM to install QuickDraw 3D

¥ Drag & Drop Manager (built into System 7.5 and later)
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◆ Installation

Before installing 3D World, we recommend that you turn off any virus protection software. 

1. Insert the CD into the CD drive and double click on the CD icon on the desktop to dis-
play its contents.

2. Double-click on the 3D World Installer icon:
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Follow the instructions in the dialogs that display to install the complete 3D World application, 
plug-ins, Librarian application and QuickDraw 3D software. After installation you will need to 
restart your Mac.

The QuickDraw 3D software will be installed in the appropriate places on your hard drive. The 
Librarian application and its associated Þles will be placed in a folder called Librarian, and the 
remaining items will be placed in a folder called 3D World 3.0, on your hard drive:

◆ Plug-ins

3D WorldÕs plug-in architecture allows plug-ins to be used to add functionality to the applica-
tion in many different ways. Plug-ins may be available in more than one category:

Import Plug-ins: Plug-in functions accessed via the Import submenu in the File menu.

DXF MacInteriors VRML 1.0 Format

Extrude Bitmap Relief
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Export Plug-ins: Plug-in functions accessed via the Export submenu in the File menu.

Menu Plug-ins: Plug-in functions accessed via the Plug-in menu in the application menu bar.

Plug-in Palettes: Palettes provide a range of options for a speciÞc feature. Display a palette by 
selecting its name from the Palettes menu.

Idler Plug-ins: Run constantly once loaded.

3D Movie DXF File VRML 1.0 Format

3DMF Text Picture

3D Controller Delete Attributes Save Textures

Add UV Draw Direct Scale Object

Animate Camera Earthquake Size Window

Animate Color Floors And Ceilings Surface Area

Animate Textures Gravity Spin

Array Duplicate Interactive Timer

Bomb Make Wireframe To Interactive

Color Material Turbocharge

Convert To Mesh Rain Use Conics

Counter Random Color

3D Controller Construct Nudge

Alignment CSG Picker

Animation Player Find RAM

Animation Tweener Gradient Renderer Options

Axis Group Special Section

Bevel Layers Subdivision

Camera Lights Textures

Color Palette NaviCam Tripod

Draw Direct Idler PhotoLink Status
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Plug-in Geometries: Plug-in tools to create shapes. Accessed from the Tool Palette.

Plug-in ModiÞers: Plug-in tools to modify objects. Accessed from the Tool Palette.

◆ Installing Plug-ins

3D WorldÕs plug-in architecture that makes it easy to add tools to Ôcustom buildÕ the applica-
tion and extend the programÕs functionality. Plug-ins can be palettes, tools, menu items or 
idlers. 

Plug-ins can be loaded when the application starts up by placing them in the Plug-ins folder 
inside the 3D World 3.0 Folder. Plug-ins can also be ÔhotÕ loaded as needed, individually or in 
groups, while the application is running.

3D Text Lathe Pyramid

4 Walls Math Graph Regular Polygon

Cone Mountain Relief

Cube Mountains Sound Marker

Cylinder Multi Walls Sphere

Dimension Pie Chart Spot Lights

Gears Pipes Text Marker

Irregular Polygon Point Lights Torus

3D Paint Edit NURB Random Color

Add UV Edit Path Scale Object

Animate Color Edit Vertex Shear

Animate Object Gravity Spin

Animate Textures Internet Sun Direction

Bomb Light Director Teleport

Color Make Wireframe Triangulate

Construct Material VR

Delete Attributes Orbit Walkthrough

Distance Pencil
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To make the best use of available memory it is recommended that the plug-ins always used 
with 3D World are placed in the Plug-ins folder and loaded when the application is launched. 
Additional plug-ins can then be loaded as required, while the application is running.

When Import, Export, Idler, Menu Command and Palette plug-ins are loaded they appear in the 
appropriate locations in the application menus. Palettes loaded when 3D World is launched will 
be opened if they were open last time the application was closed. Palettes loaded when the 
application is running will open automatically. Plug-in Geometries and ModiÞers will be added 
to the Tools palette, which grows dynamically to accommodate them. See ConÞguring The 
Tools Palette on page F-2 for more details.

Brief information about 3D World plug-ins is available via the Apple Menu. Select About Plug-
ins from the Apple Menu and a popup menu lists the installed plug-ins. Select the name of a 
plug-in to display a dialog containing information about that plug-in.

Loading Plug-ins when 3D World is Launched

Place any plug-ins to be loaded when 3D World is launched inside the Plug-ins folder. Plug-ins 
can be grouped inside folders and the folders placed in the plug-ins folder if required. This 
allows you to group plug-ins together in folders as per your requirements, and load or unload 
them as a group by dragging the folder in or out of the Plug-ins folder.

Note: Hold down the Shift key when launching 3D World to stop all plug-ins from loading.

Note: Plug-in renderers from third party companies can be accessed by 3D World if they are 
installed in the Extensions folder. 

Loading Plug-ins while 3D World is Running

Plug-ins not loaded when 3D World is launched can be loaded, while the application is run-
ning, in the following ways:

¥ Double click on a plug-in icon in the Finder.

¥ Drag a plug-in icon into the 3D World Tool palette.

¥ Drag a plug-in icon into the main 3DWorld document window.

¥ Drag a folder containing plug-ins into the Tool palette. All the plug-ins in the folder will be 
loaded.

¥ Drag a folder containing plug-ins into the main 3D World window. All the plug-ins in the 
folder will be loaded.
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Note: When a plug-in, for example the Cube tool, is dragged and dropped into the Tool palette 
or document window, a cube is not added to the document, the cube tool is just added to the 
Tool palette.

◆ Working EfÞciently

If your computer has over 32 Mb of memory, you may want to increase the amount of RAM 
allocated to both 3D World and Librarian by 1024K (1Mb). This will allow you to drag and 
drop large sounds, textures, and background pictures into your documents. 

Note: AppleÕs QuickDraw 3D uses available free system memory to perform its functions. 
Therefore, you will need at least 1 Mb of free memory after 3D World has been launched. To 
Þnd out how much memory is available, click on the desktop, pull down the Apple menu and 
select About This Macintosh. The largest unused block section of this dialog represents the 
amount of free memory. 

◆ Help

Balloon Help is available for menu items. Select Show Balloons in the Help Menu, and move 
the cursor over items in the 3D World menus to display balloons containing help messages. 
Select Hide Balloons if you do not wish the help information to display.

If you are using ATI QuickDraw 3D Accelerator Hardware, see the following section for help 
dealing with any problems.

3D World Online Manual

The 3D World Online manual is included on the 3D World CD in pdf format. It will be placed 
in the 3D World 3.0 folder during the installation process. To access the online manual, launch 
3D World and select 3D World Online manual from the help menu. A table of contents will dis-
play, allowing you to easily navigate through the pdf documents making up the complete man-
ual.
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◆ ATI QuickDraw 3D Accelerator Hardware 

Many of the most recent Macintosh computers, such as the 6500 and G3 series, include ATI 
QuickDraw 3D accelerator hardware chips on the computerÕs motherboard. The ATI Quick-
Draw 3D Acceleration hardware can also be purchased in the form of a PCI card to use in a PCI 
Macintosh computer. These ATI hardware products include XClaim 3D, XClaim VR, and Rage 
Pro.

Troubleshooting

QuickDraw 3D hardware acceleration stops due to insufÞcient VRAM

The ATI QuickDraw 3D accelerator hardware also runs the video, and the hardwareÕs capabili-
ties are determined by the amount of VRAM available. If the hardware runs out of VRAM, 
QuickDraw 3D hardware acceleration will stop working and QuickDraw 3D will revert auto-
matically to software rendering.

To increase the amount of VRAM available for QuickDraw 3D acceleration try the following:

¥ Reduce the size of the largest 3D World QuickDraw 3D window. If you are working with 
multiple windows open, the amount of VRAM used is determined by the largest window, 
but smaller windows may still be accelerated.

¥ Reduce the monitor color depth to thousands of colors.

¥ Reduce the monitor resolution towards 640 x 480.

¥ Install more VRAM

Textures do not display

If many textures are used in a document, there may not enough VRAM to store them. In this 
case the textures will not be displayed when using hardware acceleration.

Try the following solutions:

¥ Increase the texture compression setting in the ATI control panel.

¥ Increase the amount of VRAM available using one of the methods listed above.

¥ Turn off hardware acceleration in the Renderer Options palette. Software rendering uses 
real RAM to hold the textures.
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Transparencies do not display

Transparency is a function of hardware acceleration and will not be seen if hardware accelera-
tion is not running.

Try the following solutions:

¥ Check that hardware acceleration is turned on in the Renderer Options palette.

¥ Increase the amount of VRAM available using one of the methods listed above.

◆ Technical Support

You must register your product in order to receive technical support, as well as upgrade and 
new product information. In North America, South America and the Far East, please contact: 

Microspot USA, Inc.
12380 Saratoga-Sunnyvale Road, Suite 6 
Saratoga, CA 95070
USA

Technical Support: (408) 257-4000; International: + 1-408-257-4000
FAX: (408) 253-2055; International: + 1-408-253-2055

Email: support@microspot.com
Web Pages: www.microspot.com

In Europe and other parts of the world, please contact:

Microspot Limited
London House
5-11 London Road
Maidstone
Kent
ME16 8HR
England

Phone: 01622-687771; International: + 44-1622-687771
FAX: 01622-690801; International: + 44-1622-690801

Email: support@microspot.co.uk
Web Pages: www.microspot.co.uk
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